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1.0

2.0

Introduction

This QuStream Technical Bulletin presents a procedure for in-field firmware and
software updates to the PERC2000 (P2K) System Controller, the PERC1000 (P1K)
Frame Controller and the operating software on all DRS boards. These updates add
features and functionality to the P2K GUI application, implement a method of setting IP
addressing on the P1K modules directly from the P2K GUI, add new functions,
improvements and updates to the DRS audio router and other critical updates to the P2K
system.

It is IMPERATIVE that you follow the procedure in this document in the order presented
and perform the steps exactly as written. Variations to this procedure can cause severe
damage to the equipment and result in erroneous operation or render the equipment
completely inoperative!!

QuStream HIGHLY recommends that you read through all the steps of this procedure to
familiarize yourself with the scope of work BEFORE you begin performing these
procedures on actual hardware.

Update Procedure Overview

A complete update consists of performing the following procedures in the order
presented:

* Retrieve update files from the QuStream web site, store these files in a dedicated
folder on the local hard drive of the host PC and launch the newly downloaded P2K
GUI application.

e Save the current P2K configuration and matrix preset data to files on the host PC for
later retrieval.

e Perform the firmware update procedure on the P2K system controller through the
updated GUI and clear the contents of on-board non-volatile memory.

e Perform the firmware update procedure on all P1K frame controllers in the system.

e Perform the software update procedure on all DRS DXE core boards and audio I/O
boards.

¢ Reload the saved configuration and matrix preset data to the P2K System Controller.

Time to complete all steps of this procedure will vary, depending on the number of
system devices to update. On average, you should plan on a minimum of 4 hours
system down-time to complete this procedure. Your time invested in performing this
update will be well rewarded with the new functionality and features it brings to your
system.
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Each paragraph below contains a step-by-step procedure for updating the device. A
check-off box is provided by each step. Place a check in the box upon completion of
each step so that you do not miss a step. The order of performing these steps is critical
to a successful outcome of the procedure.

3.0 Equipment Needed

You will need a Windows™ based PC connected via an Ethernet connection to the P2K
to update.

4.0 Preliminary Steps

Prior to beginning the actual firmware/software update procedures, perform these
preliminary steps. Check off each step as completed:

] 1. Make a folder on the host PC where you can store the files needed for completion of
the updates. What you name this folder is up to you, but be sure that there are no other
files in the folder that might be confused with the update files.

] 2. Make four subfolders, Figure 1, within the newly created folder and name them: P2K
GUI, P2K PBN, P1K and DRS.

< H » ——

Fle Edt View Favortes Tooks Help : Oe«k Q- B ) search !6 Foiders |  Address |2 C:\Documents and Settings|
: L | : i
Folders X  Neme - Size  Type Date Modfied Date Picture T
@ oesitop o LJDRS File Folder 10/18/2007 8:46 AM
@ ) My Documents LIPIK File Folder 10/18/2007 8:46 AM
® W My Computer LIP2K GUI File Folder 10/18/2007 8:45 AM
@ S My Network Places LIP2K PEN File Folder 10/18/2007 8:46 AM
4/ Recydle Bin
SRy idate Files
) DRS
L PIK
L) P& GUt
) P PBN f\§

# 1) TechPubs Working Files

Figure 1. Update File Folder Structure

D 3. Open a browser window to the QuStream website, www.qustream.com, Figure 2.
Select the Software Downloads option from the Support menu listing. Download the
following file from the Software Downloads listing to the folder you just created:

P2K_DRSUpdate1007.zip
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Once this single file is downloaded from the website, unzip this file into the folder. The
following four .zip files are contained in the P2K_DRSUpdate1007.zip file:

PERC2000_V2_0_PBN.zip
PERC2000.zip
P1k_app_v2_0.zip
CustomerUpdatelmages.zip

After the four .zip files listed above are extracted from the downloaded .zip file, you may
delete the file P2K_DRSUpdate1007.zip from the folder.

2 QuStream ( orporation - Microsoft Internet Explorer
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< 4] Customize Licks 48] Fres Hotmai 4] Windows 0 Windows Markatplace @] Windows Media
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* Group of Companies
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Manuals
Technical Papers

H ownloads |

uStream

Group of Companies

AbokUs | Produts |
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Protocol System & or Coax . "
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RECENT NEWS

Figure 2. Location of Update Files on QuStream Website

] 4. Unzip the file PERC2000.zip to the folder labeled P2K GUI. Verify that the following
file was unzipped to the P2K GUI folder:

PERC2000.exe

] 5. Unzip the file PERC2000_V2_0_PBN.zip to the folder labeled P2K PBN. Verify that
the following files were unzipped to the P2K PBN folder:

P2KMainBoot_V2_0_10-9-2007.pbn
P2KMainDebug_V2_0_10-9-2007.pbn
P2KMainApp_V2_0_10-9-2007.pbn
P2KRTCPUboot_V2_0_10-9-2007.pbn
P2KRTCPUcopy_V2_0_10-9-2007.pbn
P2KRTCPUburn_V2_0_10-9-2007.pbn
P2KRTCPUApp_V2_0_10-9-2007.pbn
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] 6. Unzip the file P1k_app_v2_0.zip to the folder labeled P1K. Verify that the following
file was unzipped to the P1K folder:

p1k_app_v2_0.pbn

] 7. Unzip the file CustomerUpdatelmages.zip to the folder labeled DRS. A subfolder
named CustomerUpdatelmages will be created under the DRS folder. Verify that the
following files were unzipped to the CustomerUpdatelmages folder:

Cust-Aesinput_Rev11_4_7-20-2007.pbn
Cust-AesOutput_Rev11_4_7-20-2007.pbn
Cust-Analoginput_Rev11_3_7-20-2007.pbn
Cust-AnalogOutput_Rev11_3_7-20-2007.pbn
DXE_Rev12_8.pbn

] 8. Open the folder labeled P2K GUI and double click on the file PERC2000.exe to
launch the new P2K GUI application. You will use this new GUI application to complete
all steps of this procedure. The new GUI home screen is shown in Figure 3.

] 9. Click on the “Connect to Controller Symbol,” Figure 4, to bring up a box with all P2K
controllers listed by IP address. In most applications there will only be one controller
listed. Select the P2K you wish to update from the list, by IP address, and click to
activate the connection between the GUI and the controller. Once activated and
communication is established, the IP address of the P2K appears in the box to the right
of the connection symbols and the box is highlighted green to indicate the connection is
functional.

] 10. Proceed to Paragraph 5.
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SPEsA PIRC 2000 - Untitled il 3
Fle EM Vew Configration Cootroer  Help
Ded # ? %2 & o Ho Connection ]
= Corbiguration
Levels Configuestion Mame  [Unisind
Comparents SR A HEATe
Categories Choo Rete [10 i
Scurces - Hewirem |
Destrators PRC Delawr
Reentries
5 O S
Source-Dest Blocks 358 Belonies Daliatte
Saivo Groups Status Name
Loved Inchade Lists Syec 1 ] «
Data Ky Lists Sync2 [ Defned
Salvo Koy Lists
Sabvo Inchode Lists
Source Inchude Lists | Serial Port Configus ation
Destration Inchude Lists Requesto Lock Flow USP Status
Panels § Protocol Checksum  Terminatos Code Priority Port Type  Baud Raste Stop Bits Control Filter
- Retus | Peat - 1.024 0 Modly
Mot b Pot 2 Here 1.025 0 Modty
P e Port 3 PRC H 1008 0 RS4Z2  IMOBPS  1STOPBIT M Modty
Parel Xatus b e stris : G sl
Sabvo atus Port 4 tome 1027 0 Modly
= Martenancsiuagnotics
. R Fr r
'S Matrix Frames [ Info
| 1P Addvess
| Subnet Mask 2600
| Default Gateway anan
| Teinet Port [

Fox Help, press F1

Figure 3. P2K GUI Home Screen
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Figure 4. System Controller Selection

Save Current P2K Configuration and Matrix Preset Data

1. Ensure that the IP address of the P2K you wish to update is displayed by the
Controller Active box and that the box is highlighted green to indicate a functional
connection, as shown in Figure 5. If the box is not green or the indicated IP address is
not correct, repeat steps 8 and 9 of Paragraph 4 before continuing.

2. The following steps generate a file of the current configuration loaded into the P2K
and a second file containing the current status of the matrix. DO NOT SKIP THESE
STEPS!! Save these files into a folder on the host PC for later retrieval. Once the
update is complete, these files will allow you reload the controller configuration and
return the matrix crosspoints to their current status. In our example screens, the files are
saved into the folder created for the update files. This is a convenient place to store the
files, however, you may write these files to any folder you wish — just be sure you can
retrieve them easily when needed.

3. Click on the File menu in the Windows™ menu bar and select the “Upload From
Controller” option from the menu as shown in Figure 5.
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Figure 5. File Menu Listing

] 4. The dialog box shown in Figure 6 will appear. Click Yes to proceed with the

configuration upload.
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Figure 6. Caution Dialog Box

] 5. Once the configuration file is uploaded to the PC, the dialog box shown in Figure 7
will appear. Click OK to clear the box.
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Figure 7. Upload Complete Dialog Box
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[l

6. Click on the File menu in the Windows™ menu bar and select the Save As option
from the menu as shown in Figure 8.

TIELINE HD-12 Masters 07 - TIELINE HD-12 Masters (

N'sh PERC 2000 - TIELINE HD-12 Masters 07
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e
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*Sodrce Inoude Lsts
# Destination Include Lists
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Protocol  Checksum

Po1 WG eese
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CRLF

Figure 8. Save As Command Location

]

7. The Save As box, Figure 9, is displayed. Select a folder for the file, give the
configuration file a name and click Save to save the file on the host PC.
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Figure 9. Save As Browse Box
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[l

8. Locate and click on the Matrix Preset command in the left pane of the GUI display, as

shown in Figure 10. This action will bring up the Matrix Preset display as shown. Click
the Get Matrix Current button as shown. Be sure that the screen updates to the current
matrix display before continuing.

Matrix Presel
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Figure 10. Matrix Preset Screen

shown in Figure 11.

9. Once the window updates with the current matrix status, click the Save button as
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Figure 11. Save Preset Button
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O

6.0

10. The Save As box, Figure 12, is displayed. Select a folder for the file, give the matrix
preset file a name and click Save to save the file on the host PC.
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Figure 12. Save File Browse Box

11. Verify that both the configuration file and the matrix preset file were written in the
selected folder. DO NOT proceed without having these two files saved to a folder where
they can be easily located for retrieval.

PERC2000 Update Procedure

Updating and reprogramming the P2K system controller involves multiple steps. Seven
firmware modules are loaded into flash memory on the board, per the procedural steps
in Paragraph 6.1. Once all seven modules have been loaded, the non-volatile memory
of the P2K must be completely cleared per the procedural steps in Paragraph 6.2. Itis
imperative that you complete the steps of Paragraph 6.1 for all seven modules before
proceeding to Paragraph 6.2. Do not take any of the following steps out of the sequence
listed here. Severe damage can occur to the controller board.
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6.1
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P2K Firmware Module Updates

The following steps update the firmware loaded into flash memory on the P2K controller.
If you have more than one P2K system controller in your system, follow the steps in this
paragraph for each controller board.

You will install seven files into the P2K memory. One of these is the
P2KMainApp_V2_0_10-9-2007.pbn file. Please note that this file can take from 6 to
more than 20 minutes to load!! Wait for the GUI to confirm the update has completed. If
you stop the load process prematurely irreparable damage WILL occur to the P2K
Controller.

1. If it is not already running, launch the newly released P2K GUI application by double
clicking the PERC2000.exe file contained in the P2K GUI folder you created in
Paragraph 4.

2. Verify the P2K PBN folder you created in Paragraph 4 contains the files shown in
Figure 13. All of these files are used in the update procedure.

Figure 13. P2K PBN Folder Contents

3. Click on the Help menu in the Windows™ menu bar and select the “Flash Utility”
option from the menu as shown in Figure 14.
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Figure 14. Flash Utility Command Location

] 4. This will bring up the Flash Utility window as shown in Figure 15. All devices in the
system that are under control of the GUI and assigned an IP address are displayed in
the top box of the window. Locate the P2K system controller board by IP address and
click on the entry. The entry is highlighted as an indication it is the device chosen for
flash update.
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Figure 15. Flash Utility Screen
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] 5. Entries in the Module Type listing identify the various firmware modules and routines
that comprise the controller operating code. We will be updating seven of these
elements, but the order of updating is critical and must be followed exactly as presented
in the following steps. Use the scroll bar in the Module Type window to locate the
module named PERC2000RT CPU Burn, as shown in Figure 16, and click on this entry
to highlight the module name. Click the cursor in the Module Update box on the
command Update Flash.
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e R W
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e et s } Entity ID Entity Type Entity Info -
Panels Con
= Status
Matrix Status
Matrix Preset Nol
Panel Status
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= Maintenance/Disgnostics ;
& DRS Motrix Frames Module Type Module Version | Module Update =]
PERC2000 RT CPU Boot 04 Update Flash
PERC2000 RT CPU Copy 03 Update Flash
PERC2000 RY CPU App. 010 Update Flash E;

Figure 16. Update Flash Command Location

] 6. The Open Flash Update File window is displayed, Figure 17. Browse to the folder
named P2K PBN that you created in Paragraph 4. Locate and click on the file named
P2KRTCPUburn_V2_0_10-9-2007.pbn. The file will appear in the File Name box.
Click the Open button on the window.
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Figure 17. Open Flash Update File Browse Box

7. The OK to proceed? window, Figure 18, is displayed. Click the Yes button to begin

the reprogramming operation.
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Figure 18.

Caution Dialog Box

] 8. When the module has been reprogrammed, the GUI will display a window stating that
the Flash Update was successful as shown in Figure 19. Click OK to clear the window.
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Figure 19.

Flash Complete Notification Box

] 9. At the completion of each module reprogramming operation, repeat the procedure
outlined in steps 5 through 8 for the remaining modules IN THE ORDER LISTED
BELOW. Locate the Module Type in the scroll list on the Flash Utility screen and use
the module file listed in each step from the files located in the P2K PBN folder.

O PERC2000 RT CPU Burn using the file named P2KRTCPUburn_V2_0_10-9-
2007.pbn from the P2K PBN folder (This was completed in the steps above).

O PERC2000 RT CPU Boot using the file named P2KRTCPUboot_V2_0_10-9-
2007.pbn from the P2K PBN folder.

Ol PERC2000 RT CPU Copy using the file named P2ZKRTCPUcopy_V2_0_10-9-
2007.pbn from the P2K PBN folder.

O PERC2000 RT CPU App using the file named P2KRTCPUApp_V2_0_10-9-
2007.pbn from the P2K PBN folder.

O PERC2000 Main Boot using the file named P2KMainBoot_V2_0_10-9-2007.pbn
from the P2K PBN folder.
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O PERC2000 Main Debug using the file named P2KMainDebug_V2_0_10-9-2007.pbn

from the P2K PBN folder.

O] PERC2000 Main App using the file named P2KMainApp_V2_0_10-9-2007.pbn from

the P2K PBN folder.
WARNING
The PERC2000 Main App module can take from 6 to more than 20 minutes to load!!
Wait for the GUI to confirm the update has completed. If you stop the load process
prematurely irreparable damage WILL occur to the P2K Controller.

] 10. When all seven modules have been installed, exit the GUI application and reboot
the P2K controller using the RESET switch on the edge panel of the card or by removing
and reapplying power to the card.

] 11. Restart the GUI application and select the Flash Utility command under the Help
menu. Select the system controller you just reprogrammed, by IP address, from the list.
Verify that the version numbers, listed in the Module Version column, reflect the
following chart:

Module Type Module Version Module Update
Protocol 1.0 N/A
Hardware 1.0 N/A
PERC2000 Main Boot 2.0 Update Flash
PERC2000 Main Debug 2.0 Update Flash
PERC2000 Main App 2.0 Update Flash
PERC2000 Main CPLD See Note Below Update Flash
PERC2000 RT CPU Boot 2.0 Update Flash
PERC2000 RT CPU Copy 2.0 Update Flash
PERC2000 RT CPU Burn 2.0 Update Flash
PERC2000 RT CPU App. 2.0 Update Flash

NOTE: The version of the PERC2000 Main CPLD will not change from what it was originally.

] If the version numbers are correct, proceed to Paragraph 6.2. If any number does not

indicate the updated version number, repeat steps 5 through 8 for that firmware module
only. After completion of load, reboot the controller and verify the module version

numbers.
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OO O d

Clear Contents of Non-Volatile Memory
1. When the firmware update is complete and verified, exit the P2K GUI application.

2. Remove the P2K controller board being updated from the Cheetah chassis or its
stand-alone frame and set it on a static free work surface. It is not necessary to remove
power to the frame prior to removing the controller board.

WARNING

DO NOT PERFORM THE NEXT STEPS WITH THE P2K CONTROLLER
BOARD INSTALLED IN THE CHASSIS!!!!

3. Use Figure 20 as a reference and locate jumper header J15. Orient your P2K board
in the same position as the illustration. J15 is a six pin header with pin 1 on the right
side and pin 6 on the left, as shown. For normal board operation, a shorting jumper
connects pins 1&2 and pins 5&86, View A of Figure 20.

4. Remove the left side shorting jumper from pins 5&6, and install on pins 4&5 as shown
in View B of Figure 20.

5. Leave the shorting jumper in place on pins 4&5 for 20 to 30 seconds, minimum. This
step will deplete power from the capacitors providing memory-hold voltage and allow the
non-volatile memory to lose its data.

6. Return the shorting jumper to pins 5&6 of J15.
WARNING
DO NOT RE-INSTALL THE P2K BOARD INTO THE CHASSIS WITH
THE JUMPER ON PINS 4&5. THIS WILL CAUSE A DIRECT SHORT
ON THE POWER RAIL!!!

7. Reinstall the P2K controller in the Cheetah chassis or the stand alone rack mount
frame.

8. If you did remove power to the frame prior to removing the controller, reapply power
to the frame at this time.

9. Verify that you can communicate with the P2K.

10. If you have more than one P2K system controller in your system, repeat all steps of
Paragraph 6.1 and 6.2 for all controller boards you have. Once all controllers have been
reprogrammed, proceed to Paragraph 7.0
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Figure 20. P2K Controller Jumper Location
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7.0

7.1

PERC1000 Update Procedure

Updating and reprogramming the P1K frame controllers is similar to the process just
performed for the P2K system controller. This update procedure also involves multiple
steps. Only one firmware module is loaded into flash memory on the board, per the
procedural steps in Paragraph 7.1. Once the firmware module load is completed, the
base IP address of ALL P1K frame controllers must be set the same using the P2K GUI
per the procedural steps in Paragraph 7.2. Do not perform any of the following steps out
of the sequence presented here.

P1K Firmware Module Update

The following steps update the firmware loaded into flash memory on the P1K frame
controller. If you have more than one P1K frame controller in your system, follow the
steps in this paragraph for each controller board.

1. Verify the P1K folder you created in Paragraph 4 contains the file shown in Figure 21.

W P1K

: . g | o 3
Fle Edt View Favorites Tooks Help Qs - O (T O seach | Foiders | Address [[2) C:\Documents and Settings}

Folders X Name Size  Type Date Modified Date Pid
@ vesktop [ p1k_app_v2_0.pbn 1,144KB PBNFile 9/25/2007 3:01 PM

# L} My Documents R
# § My Computer
¥ N My Network Places
# Recyde Bin
= ) P2K Udste Files
@ L) ORS
(]
2 P2K GUT
L) P2K PBN

Figure 21. P1K Folder Contents

2. Ifitis not already running, launch the newly released P2K GUI application by double
clicking the PERC2000.exe file contained in the P2K GUI folder you created in
Paragraph 4.

3. Click on the Help menu in the Windows™ menu bar and select the “Flash Utility”
option from the menu as shown in Figure 22.
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B PESA PERC 2000 - Untitled
File Edit View Configuration Controller EREP
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- m i 1P Config Utility
System Parameters
Levels ¢ [Unttled
Components | About PERC2000...
Categories Chop Rate: {10
Sources
Destinations PRC Delay: 150
Reentries
Tielines

S

Source-Dest Blocks St:("c
Salvo Groups e
Level Include Lists Sync 1
Data Key Lists Sync 2 [ Define
Salvo Key Lists
Salvo Inchude Lists
Source Include Lists
Destination Include Lists
Panels Protocg
Matrix Status Port 2 ' None
Matrix Preset 1
Panel Status s il
Salvo Status Port 4 None

+ Maintenance/Diagnastics

—

Figure 22. Flash Utility Command Location

] 4. This will bring up the Flash Utility window as shown in Figure 23. All devices in the
system that are under control of the GUI and assigned an IP address are displayed in
the top box of the window. Locate the P1K frame controller you wish to update by IP
address, it will be listed as Device Type DRS Matrix, and click on the entry. The entry is
highlighted as an indication it is the device chosen for flash update.

] 5. The middle pane of the Flash Utility window identifies the entities within the selected
DRS matrix, and lists them in the column titled Entity Type. An entity is any of the
components making up the matrix such as the DXE Core Board (listed as DRS Core
Board) and the audio input and output boards. Clicking on any entry in the Entity ID list
selects that entity as the component on which you wish to perform flash memory
reprogramming and determines which firmware/software modules are listed in the
Module Type pane, as discussed in Paragraph 6. Firmware modules for the P1K
controller are contained in the same list as the DXE Core Board. In order to access the
P1K firmware module for reprogramming, be sure that the DRS Core Board entry in the
Entity ID listing is highlighted, as shown in Figure 23.
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Figure 23. F

[

6. Entries in the Module Type listing i
that comprise the controller operating

lash Utility Screen

dentify the various firmware modules and routines
code. Use the scroll bar in the Module Type

window to locate the module named PERC1000 App., as shown in Figure 24, and click

on this entry to highlight the module n
on the command Update Flash.

ame. Click the cursor in the Module Update box
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Figure 24. Module Type Listing

7. The Open Flash Update File window is displayed, Figure 25. Browse to the folder

named P1K that you created in Paragraph 4. Locate and click on the file named
p1k_app_v2_0.pbn. The file will appear in the File Name box. Click the Open button on

the window.
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Figure 25. Open Flash Update File Browse Box

L] 8. The OK to proceed? window, Figure 26, is displayed. Click the Yes button to begin
the reprogramming operation.
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Figure 26. Caution Dialog Box

] 9. When the module has been reprogrammed, the GUI displays a window stating that
the Flash Update was successful as shown in Figure 27. Click OK to clear the window.
The P1K controller automatically reboots after completion of the firmware upgrade.
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Figure 27. Flash Complete Notification

10. At the completion of each module reprogramming operation, repeat the procedure
outlined in steps 4 through 8 for the remaining P1K frame controllers in the system. It is
not necessary to exit the Flash Utility Screen before continuing to the next P1K. Simply
select the IP address of the next P1K in the IP Address menu list until all frame
controllers have been reprogrammed. Do not proceed to the next step until all frame
controllers have been reprogrammed.

11. Once all P1K controllers have been reprogrammed, use the Flash Utility Screen to
verify that the Module Version number of the PERC1000 App. Module is 2.0 for each
P1K (noted as Device Type DRS Matrix) in the IP Address listing.

If the version numbers are correct, proceed to Paragraph 7.2. If any controller does not
indicate the updated version number (2.0), repeat steps 4 through 8 for that P1K
controller only. After completion of reload, verify the module version number.

Reset Base IP Address on All P1K Controllers

One of the functional changes introduced by this firmware update is the ability to set the
base IP address of the P1K frame controller through the P2K GUI. It also provides much
more latitude in assigning IP address numbers for a particular system installation. Prior
to this update, P1K IP addresses were defined as being 192.168.1.2XX, with the last
octet assigned by the system controller based on the setting of the rotary switch in a
particular DXE frame. It was possible, using a TelNet Session to change the base IP
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address of the first three octet values to values other than 192.168.1; however the fourth
octet was always assigned by the system controller as beginning with address 201 and
followed the assignment pattern as shown in Table 1. If you did change any part of the
IP address in the first three octets, substitute the base address you entered for
192.168.1 in the table entries.

[l

DXE Rotary | Primary/Redundant DXE 1/0 IP Address IP Address
Switch Setting DXE Range Controller in Slot 1 Controller in Slot 2
0 Primary 1-512 192.168.1.201 192.168.1.202
1 Primary 513 -1024 192.168.1.203 192.168.1.204
2 Primary 1025 — 1536 192.168.1.205 192.168.1.206
3 Primary 1537 - 2048 192.168.1.207 192.168.1.208
- Redundant 1-512 192.168.1.209 192.168.1.210
5 Redundant 513 -1024 192.168.1.211 192.168.1.212
6 Redundant 1025 — 1536 192.168.1.213 192.168.1.214
7 Redundant 1537 - 2048 192.168.1.215 192.168.1.216
Table 1.

The firmware update you are installing now allows the base IP address of the P1K frame
controllers to be set to any value that best suits your network, with a few caveats:

e You may set the first three octets of the IP address to any values needed for your
installation.

e You may assign any value to the fourth octet, keeping in mind that the number
you assign will be incremented by the system controller when assigning IP
addresses to each of the frame controllers in the system.

e When determining the number for the fourth octet you must dedicate a block of
16 numbers with the number you assign being the starting point.

For example, assume you wish to use the IP addresses 192.168.5.101 through
192.168.5.116 for the P1K frame controllers in your system. Using the P2K GUI you
would individually set the base address of each P1K in the system to 192.168.5.101. All
controllers must be set to the same address. On initial boot-up of the system, the P2K
system controller reads the setting of the rotary switch in each DXE frame, and based on
that setting dynamically assigns the increment value to each of the P1K frame
controllers in each DXE frame.

The following steps guide you through a procedure to enter any base IP address value
you wish to your P1K frame controllers. This procedure MUST be performed individually
on each P1K in the system and the same base IP address must be entered for each
controller. When determining the base IP address you wish to use, remember that you
must allow for 16 sequential numbers in the fourth octet, beginning with the number you
enter as the base address.

1. Ensure that the newly upgraded P2K system controller is installed and that the
Ethernet connection between the P2K and DXE Frame #1 is functional.
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] 2. Remove the P1K frame controllers from all DXE frames in the system and move them
all to a convenient work area physically close to system DXE Frame 1. It is not
necessary to remove power from the controller prior to removing it from the frame.

] 3. Insert a P1K into the Primary P1K Controller Slot, see Figure 28. Be sure that power
is applied to the main power connector. Allow a few seconds for the P1K to boot.

Primary P1K DXE Frame #1 Secondary P1K
Controller Slot (Viewed from Front) Controller Slot
PRI SEC

Figure 28. DXE Frame Front Panel Layout

] 4. If it is not already running, launch the newly released P2K GUI application by double
clicking the PERC2000.exe file contained in the P2K GUI folder you created in
Paragraph 4.

] 5. Click on the Help menu in the Windows™ menu bar and select the “IP Config Utility”
option from the menu as shown in Figure 29.

mPfSA PERC 2000 - Untitled
File Edt View Configuration Controfler EEEIS
Do 2R |8 § N Help Topis n

= Configuration |

System Parameters | Flash Utiity
Levels ¢ [Untit
CQmponents About PERC2000, ..
Categories Chop Rate: [10
Sources
Destinations PRC Delay: 150
Reentries
Tielines [
Source-Dest Blocks - Si
Salvo Groups et

evel Include Lig Sync 1 m

Figure 29. IP Config Utility Command Location

] 6. This will bring up the Select Device window as shown in Figure 30. There should only
be one device listed and that is the P1K you just loaded into the PRI slot of DXE frame
1. The device is listed by IP address number and it may be different than what is shown
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in the example figure. If the entry is not already highlighted, click on it. With the entry
highlighted, click the OK button to continue.

BIpESA PERG 2000 - ntitled

DEE 50 2 K2 o & o Connection ]
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Panel Status
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Figure 30. Select Device Window

] 7. The Select Device box will clear and the IP Parameters Config box, Figure 31, is
displayed. Note when the box initially appears, the IP address listed is the current
address of the controller. Click in the IP Address block and remove the currently listed
IP address. Enter the “new” IP address you have selected as the base IP address for
the P1K controllers. If, based on your network requirements, you also need to assign a
‘new” Netmask or Default Gateway setting, enter the desired values in the Netmask and
Default Gateway boxes. Default values for these settings are as shown in Figure 31:

e Netmask: 255.255.255.0
e Gateway: 0.0.0.0

The box “DHCP Active” should not be checked. In our example screen the “new” IP
address is chosen as 192.168.3.101, netmask as 255.255.0.0 and gateway as the
default value of 0.0.0.0. Click Save Changes to write the new address data to the P1K.
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Figure 31. IP Address Data Entry Box

8. Verify the new IP address loaded by clicking on the IP Config command and check
the IP address listed in the Select Device listing. It should reflect the “new” address. If
the newly assigned address is not shown in the listing, repeat steps 5 through 7 and
check the address again. Do not proceed to the next step until the P1K verifies the new
address load.

9. Leave the P1K reprogrammed in the previous steps in the PRI slot and install any
one of the remaining modules in the Secondary (SEC) Controller slot of DXE Frame 1.
Be sure that power is applied to the main power connector for the SEC slot. Allow a few
seconds for the second P1K to boot.

10. Click on the Help menu in the Windows™ menu bar and select the “IP Config Utility”
option from the menu as shown in Figure 29.

11. Just as before, this will bring up the Select Device window. However, you will now
notice that both P1K controllers are listed in the Select Device listing as shown in Figure
32. The controller in the PRI slot is listed by its newly programmed IP address: in our
example 192.168.3.101. The second controller you just installed in the SEC slot will be
listed with an IP address of the newly programmed address of the controller in the PRI
slot, incremented by a value of one. In our example note that the second controller is
listed as IP address 192.168.3.102. It is important that you realize that this address is
not yet actually programmed into flash memory of the second controller. Do not make
the mistake of thinking the address is already changed and bypass any steps of the
procedure.
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Figure 32. Select Device Window

] 12. Move the cursor to the IP address corresponding to the controller loaded into the
SEC slot. In our example you would move the cursor to the device listed as
192.168.3.102, as shown in Figure 32. Click on the entry to select it as indicated by the
selection being highlighted. Once the device listing for the SEC controller slot is
highlighted, click the OK button to continue.

] 13. The Select Device box will clear and the IP Parameters Config box is displayed.
Note when the box initially appears, the IP address listed is displayed as the current
address of the controller, as shown in Figure 33. Click in the IP Address block and
remove the currently listed IP address. Enter the EXACT SAME IP address you
selected as the base IP address for the P1K controllers and programmed into the first
P1K you changed in step 7. For our example you would enter 192.168.3.101 as shown
in Figure 34. Click Save Changes to write the new address data to the P1K in the SEC
slot. The new data will be written and the P1K will automatically reboot.
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Entering IP Address Data
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] 14. Verify the new IP address loaded by clicking on the IP Config command and check
the IP addresses listed in the Select Device listing. You should see your selected base
address displayed for the controller in the PRI slot and the base address incremented by
one for the controller in the SEC slot. Close the Select Device listing and remove the
newly reprogrammed controller from the SEC slot and set it aside. Leave the controller
in the PRI slot in place.

] 15. Repeat steps 9 through 14 for ALL remaining P1K controllers before proceeding to
the next step. When you have completed this portion of the upgrade procedure ALL
P1K controllers should be loaded with the base address you selected; in our example
that would be 192.168.3.101.

] 16. Reinstall all the P1K controllers into the DXE frames. It is not necessary to remove
power to the frame prior to reinstalling the controllers and the order you replace them is
not critical. Do remember, however, that the first controller you install in any frame will
become the active controller for that frame. So if you would like to have the primary

controllers as the active controllers, install the first P1K in the left-hand (PRI) slot of each
frame.

D 17. Once all P1K controllers have been replaced, allow a few seconds for all to reboot.
Click on the IP Config command and verify that the IP addresses listed start with the
assigned base address and increment the number in the fourth octet as shown in Table

2,
DXE Rotary | Primary/Redundant DXE 1/0 IP Address IP Address

Switch Setting DXE Range Controller in Slot 1 Controller in Slot 2
0 Primary 1-512 Base IP Address Base IP Address + 1
1 Primary 513 -1024 Base IP Address + 2 Base IP Address + 3
2 Primary 1025 - 1536 Base IP Address + 4 Base IP Address + 5
3 Primary 1537 - 2048 Base IP Address + 6 Base IP Address + 7
4 Redundant 1-512 Base IP Address + 8 Base IP Address + 9
5 Redundant 513 -1024 Base IP Address + 10 Base IP Address + 11
6 Redundant 1025 — 1536 Base IP Address + 12 Base IP Address + 13
7 Redundant 1537 - 2048 Base IP Address + 14 Base IP Address + 15

Table 2.

] 18. Close the Device Select window and continue to Paragraph 8.0.
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8.0 DRS DXE and Audio Board Update Procedure

The following steps update the firmware loaded into flash memory on the DXE Core
board and the audio I/O boards connected to the DXE. Collectively, a DXE frame and
the audio frames attached to it are referred to as a DRS Matrix. Each DRS Matrix is
identified by the IP address of the P1K frame controllers. If you have more than one
DXE frame in your system, follow the steps in this paragraph for each DXE and the
audio boards attached to it.

] 1. Verify the DRS folder you created in Paragraph 4 contains the sub-folder and files
shown in Figure 35.

W CustomerUpdateimages

»

: Fle Edt View Favorites Tools Help 3 0 Back - e\:j ‘, / Y Search f i!‘ Folders | ¢ Address |7 C:\Documents and Settings)
. ‘ | :
Folders X Name Size  Type Date Modified
(@ pesktop . @w-Aesm_Revl 1_4_7-20-2007.pbn 3,649KB  PBN File 72012007 S:11 PM
® {2} My Documents gc\n~nesolxm_kevxx_qj-zo-zmrpbn 3,649KB  PBN Fie 7/20/2007 5:11 PM
# W My Computer [ Cust-Analoginput_Rev11_3_7-20-2007.pbn 3,649KB  PBN File 7/20/2007 5111 PM
® S My Network Places ) CustanalogOutput_Rev11_3_7-20-2007.pbn 3,649KB  PBN File 7/20/2007 5:11 PM
# Recyde Bin {5 oxE_Rev12_8.pbn 2,135KB PBN Fie 9/25/2007 3:45 PM
= L P2K Udate Files
& ) DRS
L2 CustomerUpdateImages
L PIK
) P GUL
) P2K PEN

Figure 35. DRS Folder Contents

] 2. Ifitis not already running, launch the newly released P2K GUI application by double
clicking the PERC2000.exe file contained in the P2K GUI folder you created in
Paragraph 4.

] 3. Click on the Help menu in the Windows™ menu bar and select the “Flash Utility”
option from the menu as shown in Figure 36.
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] 4. This brings up the Flash Utility window as shown in Figure 37. All devices in the
system that are under control of the GUI and assigned an IP address are displayed in
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Figure 36. Flash Utility Command Location

the top box of the window. Locate the DRS Matrix you wish to update by the IP address
of the ACTIVE frame controller in the DXE, it will be listed in the Device Type column as

DRS Matrix, and click on the entry. Do not use the IP address of the standby frame
controller for this procedure. The entry is highlighted as an indication it is the matrix

chosen for flash update.

If the IP address you wish to select is highlighted when the Flash Utility
window is first open, you MUST click off of that entry to any other entry in the
list and then click back on the desired IP address entry. If you do not click off
and back on the entry, the proper Entity ID and Module Type data for this

CAUTION

procedure will not be displayed.
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Figure 37. Dev

ice Selection Window

5. The middle pane of the Flash Utility window identifies the entities within the selected

DRS matrix, and lists them in the column titled Entity Type. An entity is any of the
components making up the matrix such as the DXE Core Board (listed as DRS Core
Board) and the audio input and output boards. Clicking on any entry in the Entity ID list
selects that entity as the component on which you wish to perform flash memory
reprogramming. For this procedure you will reprogram the flash on the DXE Core board
first, followed by the audio boards. Highlight the DRS Core Board entry in the Entity ID
listing as shown in Figure 38.
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] 6. Entries in the Module Type listing identify the various firmware modules and routines

Figure 38. Entity ID Listing

associated with the entity selected in the Entity ID pane. Use the scroll bar in the

Module Type window to locate the module named DRS Core V4, as shown in Figure 39,
and click on this entry to highlight the module name. Click the cursor in the Module

Update box on the command “Update Flash.”
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] 7. The Open Flash Update File window is displayed, Figure 40. Browse to the folder
named DRS that you created in Paragraph 4 and open the folder named
“CustomerUpdatelmages.” Locate and click on the file named DXE_Rev12_8.pbn. The
file appears in the File Name box. Click the Open button on the window.
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Figure 40.

[l

the reprogramming operation.

Open Flash Update File Browse Box

8. The OK to proceed? window, Figure 41, is displayed. Click the Yes button to begin
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Figure 41. Caution Dialog Box

[

9. When the module has been reprogrammed, the GUI will display a window stating that

the Flash Update was successful as shown in Figure 42. Click OK to clear the window.
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] 10. Once you have reprogrammed the DXE Core board, you will next reprogram the

audio boards associated with the DXE you just completed.

Audio boards are listed in the Entity ID pane beneath the DRS Core Board entry as shown in

Figure 43. Notice that the entry identifies each board as to whether it is an Input board or

Output board and whether it supports AES or Analog audio. The procedure for reprogramming
flash memory on the audio boards is identical to the procedure just presented for the DXE Core

Board:

e Select the board you wish to reprogram from the Entity Type list. Be sure the desired

entry is highlighted before continuing.

e Inthe Module Type column select the entry DRS /O V4, open the Flash Update box and

select the appropriate Flash Update file (Figure 35), as shown in Table 3, from the list.

e The “OK to Proceed?” dialog box will prompt you click on Yes to begin the
reprogramming operation.

¢ Once flash update is completed the dialog box informing you that the flash operation

was successful is displayed.

e Click OK to clear the box and repeat this procedure for ALL audio board entries in the

Entity Type listing.
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Entity Type Selection

Entity Type

DRS AES Input Board
DRS AES Output Board
DRS Analog Input Board
DRS Analog Output Board

Flash Update File

Cust-Aesinput_Rev11_4_7-20-2007.pbn
Cust-AesOutput_Rev11_4_7-20-2007.pbn
Cust-Analoglnput_Rev11_3_7-20-2007.pbn
Cust-AnalogOutput_Rev11_3_7-20-2007.pbn

Table 3.

Do not reprogram audio boards in the matrix until the DRS Core Board reprogramming is

completed.

The following steps provide an example procedure for reprogramming the AES Input Board
listed in the Entity Type list under the DRS Core Board just reprogrammed. For your operation
you will use the Flash Update file listed in Table 3 for the type of board (Entity Type) you are

reprogramming.
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] 11. Clicking on an entry in the Entity ID list selects that entity as the component on
which you wish to perform flash memory reprogramming. For this example we want to
reprogram the flash on the DRS AES Input Board. Highlight the DRS AES Input Board
entry in the Entity ID listing as shown in Figure 43.

] 12. Use the scroll bar in the Module Type window to locate the module named DRS 1/0
V4, as shown in Figure 44, and click on this entry to highlight the module name. Click
the cursor in the Module Update box on the command “Update Flash.”
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Salvo Groups Status Name {
Level Include Lists
Data Key Lists
Salvo Key Lists

Saivo Include Lists | 1P Address

Device Type Serial Number Device Info
Source Include Lists 1 DRS Matnx BRO7IE (752537 11061

048 / Duk

132.168.1.207 DRS Matrix 652722807040064  Inputs 1 to 2048 / Outputs 1537 to 2048

Destination Include Lists

Panels 4
% Satus i 192168.2.41 DRS Matrix 652722807170114  Inputs 1 to 2048 / Dutputs 1 to 512

Matrix Status i 182168249 DRS Matiix 652722607030054  Inputs 1to 2048 / Dutputs 1 t0 512 =l

Matrix Preset T

Panel Status

Salvo Status Entity ID Entity Type Entity Info

# DRS Matrix Frames |nwtﬂlo512/mum512

& Bubitornnca/Disgnostics 1 DRS Core Board
13 DRS Analog Output Board 10128

Module Type Module Yersion Module Update
DRS Calibration Data N/A Update Flash

DRS 1/0 CALD 01 Update Flash

DRS 1/0 Akera 04 Update Flash

Figure 44. Update Flash Command

] 13. The Open Flash Update File window is displayed, Figure 45. Browse to the folder
named DRS that you created in Paragraph 4 and open the folder named
“CustomerUpdatelmages.” For our example, since we are reprogramming an AES Input
board, locate and click on the file named Cust-Aesinput_Rev11_4_7-20-2007.pbn. The
file will appear in the File Name box. Click the Open button on the window.
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Figure 45. Open Flash Update File Browse Box

] 14. The OK to proceed? window, Figure 41, is displayed. Click the Yes button to begin
the reprogramming operation.

] 15. When the module has been reprogrammed, the GUI will display a window stating
that the Flash Update was successful as shown in Figure 42. Click OK to clear the
window.

] 16. Repeat steps 11 through 15 for all remaining audio boards shown in the Entity Type
list for the selected DRS Matrix. Be sure that you use the correct Flash Update file as
shown in Table 3 for the board type you are reprogramming.

] 17. When you have completed reprogramming the DXE Core and all audio boards for a
DRS Matrix group, repeat steps 4 through 16 of Paragraph 8.0 for the remaining DXE
frames and associated audio boards.

] 18. When all DXE Core Boards and Audio Boards have been reprogrammed, continue
to Paragraph 9.0.
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9.0 Reload P2K Configuration and Matrix Preset Data

O] 1. Locate the controller configuration file (filename.cfg) and the matrix preset file
(flename.preset) you created in Paragraph 5.0. In the example screen, Figure 46, these
are shown as Current Config.cfg and Current Matrix.preset. Make a note of the
folder containing these files.

[»

Fle Edt View Favorkes Toos Hep Qe - D (T D seah ! i Folders | Addess (3 C:\Documents and Settings
Folders X Name Size  Type Date Modfied ~ Date Picturs|
{3 pesktop 3 Current Config.cfg 2,850KB  Microsoft Office Ou...  10/22/2007 7:48 AM
# (.} My Documents 28 Current Matrix.preset 61 KB PRESET File 10/18/2007 11:17 AM
& W My Computer §¥ PERC2000.2p 1,545KB  ZpGenius Zp File 10/16/2007 1:58 PM
& 4 My Network Places €2 p1k_app_v2_0.7ip 1,141 KB ZipGenius 2ip File 10{16/2007 1:53 PM
# Recycle Bin 0 CustornerUpdatelmages. 2ip 6,024 KB ZipGenius Zip File 10/15/2007 3:16 PM
R s Files 99 PERC2000_Y2_0_PBN.2p 4,771K8  ZpGenius Zip Fle 10/10/2007 11:37 AM
® 7 DRS [% “J0RS File Folder 107182007 2:30 PM
3 PIK LIPIK Fie Folder 10/18/2007 2:30 PM
o PG LIP2A PEN Fie Folder 10/18/2007 2:30 PM
) P2K PBN Earxeu File Folder 10/18/2007 2:29 PM

Figure 46. Configuration and Preset File Identification

] 2. Ifitis not already running, launch the newly released P2K GUI application by double
clicking the PERC2000.exe file contained in the P2K GUI folder you created in
Paragraph 4.

] 3. Click on the “Connect to Controller Symbol,” Figure 47, to bring up a box with all P2K
controllers listed. In most applications there will only be one controller listed. Select the
P2K you wish to download the configuration data to from the list and click to activate the
connection between the GUI and the controller. Once activated and communication is
established, the IP address of the P2K will appear in the box to the right of the
connection symbols and the box will be highlighted green to indicate the connection is
functional.
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Figure 47. System Controller Selection Window

] 4. Ensure that the IP address of the selected P2K is displayed by the Controller Active
box and that the box is highlighted green to indicate a functional connection. If the box
is not green or the indicated IP address is not correct, repeat steps 1 and 2 of Paragraph
9.0 before continuing.

] 5. Click on the File menu in the Windows™ menu bar and select the “Open” option from
the menu as shown in Figure 48.

B PEsA PERC 2000 - Untitled
Ul £t View Configuration Controler Help
e con W2 o o
Save Ctri4s
S Configuration Name:  [Untitled
Download To Controfier EEORSRG
Upload From Controller Chop Rate: {10
Irport 3500Pro Text File PRC Delay: {50
Export Clikcontrol Text File
o Sync Reference Defin
$ Fra Status Nam
e s | oo

1 PERCTest.cfg i Sync 2 [ Defined

Exit

Source INcge Lists . !
Nectinatinn Terkwde ficte

Figure 48. File Menu Listing
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] 6. The Open PERC 2000 Config File box, Figure 49, is displayed. Browse to the folder
containing the configuration file, and click on the configuration filename. With the name
of the configuration file appearing in the File Name box, click “Open’” to load the file as
the current configuration for the P2K GUI.

BpEsa PERC 2000 - Current Contig.cfg - Untitled

O@Fd & &0 PR e o SR
=1 Configuration
System Parameters
Levels
Components
Categories Look in [ 7 P2K Udate Fies 5] - ® ek
Sources : o @ = e SRR
Destinations f?__')DRS
Reentries ! CIPIK
Tiehnes (e
Source-Dest Blocks i (\;,pgxpm
T p——

Open PERC 2000 Config File

Level Include Lists ;L — Q
Data Key Lists |
Salvo Key Lists |
Salvo Inchude Lists T,
Source Include Lists Fiename:  [Cunent Config cfg Open l

Destination Inchude Lists

Panels Files of ype:  [PERC 2000 Config Fies (*cfg] =l __‘i'ff'_J
=l Status -

Matrix Status } Port 2 Nane 10255

Matrix Preset
Panel Status i Port 3 PRC None 1.026

Salvo Status Port 4 None 1.027

= Mairtenance /Disgnostics
+ DRS Matrix Frames

Figure 49. Configuration File Browse Box

O] 7. Once the configuration file loads, click on the File menu in the Windows™ menu bar
and select the “Download To Controller” option from the menu as shown in Figure 50.

B PESA PERC 2000 - 06 19 2006

Gl Edt View Configuration Controler Help
fod | e o R
Open... O e ———
Save Ctri+s
e Configueation Name:  [06-13-2006
Upload From Controller Q Chop Rate [T
Impart 3500Pr0 Text Fie PRCDely [SO
Export Clikcontrol Text File
Sync Reference De|
Prox. Previey Status N4
Print Setup... Sync1  INEEETET]
1 Current Config.cfg Sync 2 [ Defined
2 PERCTest.cfg
Ext
TR USSINS00N IN000e Usts
+ Panels Protocol  Checksy
- s Pt NG - st

Figure 50. Download to Controller Command Location
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] 8. The dialog box shown in Figure 51 will appear. Click Yes to proceed with the

configuration download.

mnm PIRC 2000 - 06-19-2006

DS@ -8 0 TR e o SR

= Configuration

System Parameters

+ Levels

+ Components

+ Cateqgories

* Sources

+ Destinations
Reentries
Tielinas
Source-Dest Blocks
Salvo Groups

+ Level Include Lists

+ Data Key Lists
Salvo Key Lists
Salvo Include Lists
Source Inchude Lists

' Destination Inchude Lists

© Panels

!

Configuration Name:  [06-19.2008
Chop Rate: 11

PRCDelay [0

ioad wil change the configuration n the controller! |
Do you wish to procesd?

N

= Status pot1 [GIN - Pese CALF
Matrix Status Port 2 PIE PESA CRLF
Matrix Preset i
Panel Status Fql 3‘ PRC None

Protocol ~ Checksum  Terminator

Figure 51. Caution Dialog Box

] 9. Once the configuration file is downloaded to the P2K controller, the dialog box shown
in Figure 52 will appear. Click OK to clear the box.

®pesa PERE 2000 - 06.19 2008

DER 8L TR e o S

=} Configuration

System Parameters

* Levels

* Components

+ Cateqories

+ Sources

* Destinations
Reentries
Tielines
Source-Dest Blocks
Salvo Groups

+ Level Include Lists

% Data Key Lists
Sabvo Key Lists
Salvo Include Lists
Source Include Lists

+ Destination Inchude Lists

& Panels

=i Status

Matrix Status
Mdateiv Drpcal

Configueation Name: }WBZOOS
ChopRate: |1 i
PRCOSer B0
ence Defir
Nam)

‘!l Dowenload complete!

o

Protocol Checksum|
Po ' [N - rese

Port2 | PIE PESA

Figure 52. Download Complete Notification

] 10. Locate and click on the Matrix Preset command in the left pane of the GUI display,

as shown in Figure 53. This action will bring up the Matrix Preset display as shown.

Click the Load button as shown.
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EIPisA PERC 2000 - 06 19 2006
Fle Edt view Confiwration Controler Help
DEW =2 & 2R oo G
=3 C ation
e oon it Matrix Preset
e Destinations Lock HD ANA AUD 1 AUD 2 AUD3 = s&;;mg
# Categories 1 EVS 11 camMm cAM 01 cam o1 caM o
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'y xm"’ k] EVS13 I Locked CAM 01 CAM 03 CAM 03 Ccam 03 CAM 03
i 4 EVS1 I Locked cAM 01 CAM 04 CAM 04 CAM 04 CaM 04
Source-Dest Blocks 5 EVS21 I Locked CAM 01 CAM 05 CAM 05 CaM 05 CAM 05
Sabvo Groups 6 EVS22 [ Locked CaM 01 CAM 06 CAM 06 CAM 06 CAM 06
! m:';:i"f;:’“‘ 7 EVS23 [ Locked camMor camM o CAM 01 caM o1 cAM 07
Sabvo Key Usts 8 EVS24 T Locked can o1 CAM 01 caM Ot cAMO1 CAM 08
Sabvo Include Lists 3 EVSH T Locked M CAM 01 CAM 01 caM 01 CAM 09
Source Include Usts 10 EVS 32 ™ Locked CAM 01 CAM 01 CAM 01 CaM 01 CAM 10
o S ton Bie Liks 1 EVS33 [ Locked camo CaM 01 CaM 01 caM o1 cAM 11
ot Status 12 EVS3M [ Locked cam 01 camo1 caM o CaM 01 caM 12
Matrix Status 13 EVS41 T Locked MOt CAM 01 CAM 01 CAM 01 CAM 13
e 14 EVS&2 T Locked caM 14
o bate 15 EVS43 T Locked CAM 15
S5 Mantenance/Disgnostics 1% EVS44 [ Locked oMIE o
4 DRS Matrix Frames 17 EVS 51 ™ Locked
18 EVS52 [ Locked l Destinations g
13 EVS53 [ Locked
20 EVSS4 I Locked Evs 12
21 Evset I™ Locked Evs 13
22 EVS 62 ™ Locked EVS 14
23 EVSE3 [ Locked VS 21
2 EVS64 I Locked Vs 22
2% EVS71 T Locked evs 23
% EVS72 [ Locked Evs 24
27 EVS73 ™ Locked EVS 31
28 EVSM [ Locked Evs 2
28 | EVSEl [ Locked Evs 3
30 Evs82 T Locked €V 3
3 EVS8 [ Locked Vs 41
32 EVS8t [ Locked cAM 01 Evs 42
n EVS91 [ Locked cAM D2 EVS 43
34 EVS®R2 T Locked M0 | VsM o
< | _'fJ
Cexst | (et Maiis Cuend | Takent |
Oeas Selected } Take Selected I toad
For Help, press F1

Figure 53. Matrix Preset Window

[] 11. The Open PERC 2000 Preset File box, Figure 54, is displayed. Browse to the folder
containing the matrix preset file, and click on the matrix preset filename. With the name
of the preset file appearing in the File Name box, click “Open” to load the file to the P2K
GUI.
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BPEsA PERC 2000 - D6-19-2006
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Source Include Lists
# Destination Inchude Lists
“ Panels
=1 Status
Matrix Status
Matrix Preset
Panel Status i
Sebvo St 15 EVS 43 ™ Locked
= Maintenance Diagnostics 1% EVS 44 ™ Locked
# DRS Matrix Frames 17 EVS §1 I Locked

18 EVS 52 ™ Locked

8

[PERIC 2000 Presel Fies (* peesel] 2| Cancel

Figure 54. Preset File Browse Box

] 12. Once the window updates with the current matrix status, click the Take All button as
shown in Figure 55.

B PESA PERC 2000 06192006
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29 I™ Locked VS 3
30 I™ Locked EvS 34
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Figure 55. Take All Command Location
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[l

10.0

11.0

13. Once the matrix has updated to the status of the matrix preset file, the dialog box
shown in Figure 56 will appear. Click OK to clear the box.

BXpesi PERC 2000 - 06192006
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Saivo Key Lists 8 EVS 24 ™ Locked CAM 01 CAM 1
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Figure 56. Take All Command Completion Notification

In the Event of Trouble

If you have any problems with the updating procedure or have any questions, contact
the QuStream Customer Service Department:

by e-mail — service@qustream.com
by phone — 256-726-9222 (24/7)

Congratulations!!

You have now completed the firmware/software update to your PERC2000 System
Controller(s), PERC 1000 Frame Controllers and DRS Audio Boards. The added
features and functionality will greatly enhance the flexibility of your P2K controller and
your entire DRS system.

Thank you very much for your time and effort in performing this procedure. At QuStream
our goal is to provide you, our valued customers, with the best products and support
available.
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, PESA

APPENDIX A: ETHERNET CONFIGURATION

The Matrix Frame Controller supports a variety of interfaces via the Ethernet interface. These include
NET PRC, HTTP (web browser), SNMP (Simple Network Management Protocol), and Telnet. To

configure this access, the following items will need to be configured (refer to Table 46):

TABLE 46:  Ethernet Configuration
Name Usage Default

DHCP On/Off Automatically obtain an IP address from a On
DHCP server on the network.

IP Address When DHCP is disabled, allows a fixed IP 0.0.0.0
address to be assigned to the Matrix Frame
Controller.

Subnet Mask When DHCP is disabled, allows the 0.0.0.0
specification of the subnet mask for the IP
address.

Gateway When DHCP is disabled, allows the 0.0.0.0
specification on the default gateway.

Telnet On/Off Enables or disables the Telnet server. On

Telnet Port Allows the specification of the TCP port to 23
be used by the Telnet server.

Telnet Password Specifies the password for telnet access. <blank>

NETPRC Master/Slave Enables or disables the NETPRC server. Slave
Note that the SNMP agent is disabled in
Slave mode.

NETPRC Port Allows the specification of the TCP port to 1000
be used by the NETPRC server.

Read Community Specifies the read community string for the public
SNMP agent.

Write Community Specifies the write community string for the private
SNMP agent.

Trap Community Specifies the trap community string for the public
SNMP agent.

Traps On/Off Enables or disables SNMP trap generation. Off

Authentication Traps Enables or disables SNMP Authentication Off

On/Off failure trap generation.

Trap Target IP Specifies the IP address to receive SNMP, 0.0.0.0
traps.

The configuration of these fields are accessed via the DB-9, RS-232 connector on the Matrix Frame
Controller. Communication parameters for this serial interface default to 38400 baud, no parity, eight
(8) data bits, and one (1) stop bit.
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Upon connection to the serial interface (via a communications program such as HyperTerminal), enter
the command 'ET" (for Ethernet) at the ">' prompt. The current Ethemet settings will be displayed (note
that these settings are unavailable via the Telnet interface). For example,

>et
MAC address: 02:02:02:02:02:02
SERIAL #: AAAAAA000000001
DHCP : ON
IP address 0 192.168.000.104
Subnet mask :255.255.255.000
Def Gateway 1 192.168.000.002

NETPRC - MASTER
NETPRC port : 1000
TELNET : ON
TELNET port :23
TELNET pass :

RCOMM . public
WCOMM . private
TCOMM: public

TRAP : OFF
AUTH : OFF
TARGET : 000.000.000.000
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Help on how to change one of these settings can be obtained by entering the command 'HE ET' (for
Help Ethernet) at the "™>' prompt. For example,

>he et

Syntax ET < DHCP [ON|OFF] | IP [addr] | GW[addr] |
SN [addr] | DP[port] | TN [ON|OFF] |
TP [tport] | TL[pass] | RCOMM [str] |
WCOMM [str] | TCOMM [str] | TRAP [ON|OFF] |
: AUTH [ON|OFF] | TARGET [addr] | NP [MASTER|SLAVE] >
Where DHCP ON enables client automatic IP address negotiation.
. IP [addr] allows you to set the IP address of the PMFC.
- GW [addr] allows you to set the gateway address.
: SN [addr] allows you to set the subnet mask.
. DP [port] allows you to set the NETPRC IP port.
: TN ON enables the on-board telnet server.
: TP [port] allows you to set the telnet port.
. TL [pass] allows you to set the telnet login password.
where addr is in dotted notation (ex. 192.168.1.1}.
where port is in the range [1000...65535].
: where tport is in the range [23,1000...65535].
: RCOMM [str] allows you to set the SNMP read community string.
- WCOMM [str] allows you to set the SNMP write community string.
: TCOMM [str] allows you to set the SNMP trap community string.
- TRAP ON enables SNMP traps.
: AUTH ON enables authentication traps.
- TARGET [addr] allows you to set the trap target IP address.
: NP [MASTER|SLAVE] sets the NETPRC type of the PMFC.
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>et
MAC address : 02:02:02:02:02:0a
SERIAL# : EEEEEE000000001
DHCP :ON
IP address : 192.168.000.114
Subnet mask : 255.255.255.000
Def Gateway : 192.168.000.002
NETPRC :SLAVE
NETPRC port : 1000
TELNET :ON
TELNET port : 23
TELNET pass :
RCOMM . public
WCOMM . private
TCOMM . public
TRAP : OFF
AUTH : OFF
TARGET  :000.000.000.000
>

For example, to set the read community string to 'pesa’, enter
>ET RCOMM pesa

and press return. To view your changes, wait for the ™' prompt and enter 'ET".
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APPENDIX B: SNMP

The Cheetah Matrix Frame Controller contains an SNMP v2¢ agent, which is also compatible with
SNMP v1 management stations. The agent supports the following standards:

RFC 1903 — SNMPv2 Textual Conventions
RFC 1904 — SNMPv2 Conformance Statements
RFC 1905 — SNMPv2 Protocol Operations
RFC 1906 — SNMPv2 Transport Mappings
RFC 1907 - SNMPv2 SNMP MIB Objects
RFC 1908 — SNMPv1 Coexistence

RFC 2011 — SNMPv2 IP MIB Objects

RFC 2012 — SNMPv2 TCP MIB Objects

RFC 2013 - SNMPv2 UDP MIB Objects

Two enterprise MIBs are used to provide full control of Cheetah Switchers. The first, PESA-TC MIB,
is a MIB, which defines some textual conventions. The second, PESA-MATRIX .MIB, contains objects,
which allow SNMP-based control and monitoring of one or more Cheetah Switchers.

Both of these MIBs are available at the PESA website, www.pesa.com, for electronic download. The
full-text of these MIBs are distributed on the Cheetah SW Toolkit CD that goes out with every Cheetah
system.

Note that the agent within the Matrix Frame Controller implements a subset of the PESA-MATRIX
MIB. The optional Group tables are reserved for implementation within the System Controller.

The agent is capable of managing multiple Cheetah Switchers. This is accomplished in two steps:
a) Connecting the Cheetah Switchers via the RS-422 Aux Frame Port described in this manual.

b) Set the Matrix Frame Controller, which is to communicate with your SNMP management
application to NETPRC Master. Note that if you have redundant Matrix Frame Controllers in the
Switcher, BOTH must be configured as NETPRC Master. Refer to the Ethernet section described
earlier in Appendix A to accomplish this.

¢) Set all other Matrix Frame Controllers, which you have connected, to the NETPRC Master
controller to NETPRC Slave.

The agent will then be able to configure and control all of the Cheetah Switchers in the connected
collection.

Once you have configured the Matrix Frame Controller's SNMP agent (as described in Appendix A),
you may issu¢ SNMP commands. The following commands were issued on a PC running Linux against
a pair of small Cheetah Switchers.
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